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Notices

Trademarks
AJA® and Because it matters.® are registered trademarks of AJA Video Systems, Inc. 
for use with most AJA products. AJA™ is a trademark of AJA Video Systems, Inc. for 
use with recorder, router, software and camera products. Because it matters.™ is a 
trademark of AJA Video Systems, Inc. for use with camera products.

CION®, Corvid Ultra®, lo®, Ki Pro®, KONA®, KUMO®, ROI® and T-Tap® are registered 
trademarks of AJA Video Systems, Inc. 

AJA Control Room™, KiStor™, Science of the Beautiful™, TruScale™, TruZoom™, 
V2Analog™ and V2Digital™ are trademarks of AJA Video Systems, Inc.

AirPort, Apple, Apple logo, AppleShare, AppleTalk, FireWire, iPod, iPod touch, 
Mac, Macintosh and ProRes, are registered trademarks of Apple Inc. Final Cut Pro, 
QuickTime and QuickTime logo are trademarks of Apple Inc.

Avid, Avid DNxHD and Media Composer are registered trademarks of Avid 
Technology, Inc.

Adobe is a registered trademark of Adobe Systems Incorporated in the United States 
and/or other countries.

HDMI, the HDMI logo and High-Definition Multimedia Interface are trademarks or 
registered trademarks of HDMI Licensing, LLC.

DVI is a registered trademark of DDWG.

TASCAM is a registered trademark of TEAC Corporation.

Dolby and the double-D Dolby logo are registered trademarks of Dolby Laboratories 
Licensing Corporation.

openGear® Ross, ROSS, ROSS®, and MLE are registered trademarks of Ross Video.

DashBoard Control System™ is a trademark of Ross Video.

All other trademarks are the property of their respective holders.

Copyright
Copyright © 2017 AJA Video Systems, Inc. All rights reserved. All information in 
this manual is subject to change without notice. No part of the document may be 
reproduced or transmitted in any form, or by any means, electronic or mechanical, 
including photocopying or recording, without the express written permission of AJA 
Video Systems, Inc.

Contacting AJA Support
When calling for support, have all information at hand prior to calling. To contact AJA 
for sales or support, use any of the following methods:

Telephone +1.530.271.3190

FAX +1.530.271.3140

Web http://www.aja.com

Support Email support@aja.com

Sales Email sales@aja.com

http://www.aja.com
mailto:support%40aja.com?subject=
mailto:sales%40aja.com?subject=


AJA Control Room Software v14.0	 3	 www.aja.com

﻿

Contents
Notices  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                       2

Trademarks .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                            2
Copyright  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                             2
Contacting AJA Support .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                    2

Chapter 1 – Introduction .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                            4
Overview .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 4

Supported Files and Systems .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                               4
Supported Hardware  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                    4
Installation .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                           4
User-interface .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                         5

Application Menus  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                       6
File Menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                            6
View Menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                           7
Device Menu  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .  7
Help Menu .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                           7
Preferences .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 7

Chapter 2 – Operation  .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 13
Using the Bin .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                          13
Playback Tab  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                          15
Capture Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                           17

Clip Naming .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                         20
Capture Dashboard  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                    20
Batch Capture .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                        21

Edit-To-Tape Tab .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                        22
Edit Settings Pane  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                     23

Tape Deck Timing Adjustment .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                               24
Capture Timing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                       25
Edit-to-Tape Timing .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                    25

Appendix A – Supported Read/Write Codecs .  .  .  .  .  .  .  .  .  .  .  .  .              27

Appendix B – Python Scripting Tutorial .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                  28
Python Installation  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                      28

Windows .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                           28
Apple Macintosh .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                      29

AJA Control Room Setup for Python Scripting .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                    29
Macintosh Instructions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                  29
Windows Instructions .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                  30
Simple Modifications  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                                   30

Software License Agreement  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .  .                        33

Index .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   .   . 36



AJA Control Room Software v14.0	 4	 www.aja.com

﻿

Chapter 1 – Introduction

Overview
AJA Control Room™ is a simple software application for professional quality video 
and audio capture, conversion, playback, and output. With AJA Control Room you 
can:

•	 Capture from cameras, live and tape-based sources
•	 Master-to-tape using a single application
•	 Configure your video/audio I/O via an AJA device using the AJA Control Panel 

launched from the AJA Control Room application

Supported Files and Systems
AJA Control Room supports a wide range of file-types and codecs including .mov, 
.mxf, QuickTime*, Apple ProRes, Avid DNxHD and DNxHR, DVCProHD, GoPro 
CineForm, DPX, and more.

NOTE:	 Apple has ended QuickTime for Windows support.

See Table 1 on page 27 for a complete listing of Control Room codec and 
operating system support. 

You can use AJA Control Room with a variety of AJA video and audio processing 
hardware products.

Supported Hardware
AJA Control Room supports the following AJA devices:

•	 Io 4K Plus, Io 4K, Io XT, Io Express
•	 KONA 4, KONA 3G, KONA IP, KONA LHe Plus, KONA LHi
•	 T-TAP

AJA Control Room also work with: 
•	 Avid Artist | DNxIV

Installation
AJA Control Room software is available from the AJA website:

https://www.aja.com/en/products/software/ 

https://www.aja.com/en/products/software/ 
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Control Room has four different  installer packages available depending on your 
operating system:

•	 Mac (AJA recommends macOS 10.12 Sierra or later)
•	 Win (AJA recommends Win 10 or later with all updates)
•	 Linux Redhat/CentOS 7
•	 Linux Ubuntu 14.04 LTS and Ubuntu 16.04 LTS

1.	 Locate and download the appropriate installer for your OS.

2.	 Once the installer is on your machine, double-click the file to open it.

3.	 Follow the installation wizard instructions to install AJA Control Room along 
with the AJA drivers.

4.	 After installation, the applications are ready to run.

User-interface
Figure 1.  AJA Control Room Screen Layout 

By default, Control Room opens to the page shown in Figure 1 (the default Mode 
is Playback). 

NOTE:	 Mode Select Tabs at the top of the page allow you to easily switch between 
Capture, Playback and Edit To Tape.

Playback

The Playback screen  loads files from your computer and plays them out through 
your AJA hardware.
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Capture

The Capture screen allows capturing video and audio to the computer from an 
external video/audio source, such as a VTR/DDR, using the AJA hardware. 

Edit To Tape

This is a workspace where you can perform an insert or assemble Edit to Tape to 
record your clips to a VTR/DDR.

Application Menus
These top-level application menus provide information and control of the 
workspace panes and the overall application performance. 

•	 AJA Control Room (Mac menu only)
•	 File 
•	 View
•	 Device
•	 Help

NOTE:	 Menu contents vary between the Windows and Mac menus. The following, first 
describes the menu items contained within the same menu across the platforms 
and then notes those that differ between platforms.

File Menu

The File menu includes these options for both Mac OS and Windows:

New Bin 

Opens a new blank bin panel for a new project.

Open Bin

Opens a browse window to load an existing saved bin (.crbin file)

Import Files to Bin

Imports media to bin. Also loads EDLs for setting up batch captures adding them 
to the Bin. 

Save Bin and Save Bin As

Standard file save operations.

AJA Control Panel

Opens the AJA Control Panel for setting up or changing AJA hardware.
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View Menu

The View menu offers the following view options and provides the keystroke 
commands for on-the-fly selection:

Toggle Fullscreen 

Toggles the workspace display between full screen window size and standard 
window size.

NOTE:	 The following two options are useful to hide unused setup and information space 
and maximize the Display Screen area while working with clip edits.

Show/Hide Viewer Settings

Located below the transport bar, the Viewer Setting pane is for setting up control 
operations for workspaces—Capture, Playback, and Edit To Tape.

Show/Hide Bin

Located in the left column, the Bin lists and allows selection of the clips you are 
working with.

Set Viewer Modes

The last three options select one of the three workspace modes.

NOTE:	 For more on keystroke shortcuts, see "Keystroke Commands" on page 15.

Device Menu 

If you have more than one AJA hardware device installed or connected to your 
computer, this menu allows you to select the one that AJA Control Room will use.

Help Menu

Click the AJA Software Site link to visit the AJA website for the latest release notes, 
manual and AJA software downloads.

Preferences
In Windows, the Preferences screen is under the File Menu. For Mac OS, it is under 
the AJA Control Room menu.
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This menu includes basic preferences under the following subject heads:

General Prefs 

 

User interface settings reside on this screen.

Hold onto device when app is in background 

Check this box if you want to the device held when Control Room is operating in 
the background. 

Stop Playback on dropped frames

In the default preference mode, Control Room will display a red dropped frame 
counter during Playback. If you enable Stop Playback on dropped frame, the 
counter is not displayed and the process will stop immediately if a dropped frame 
occurs.

Figure 2.  Dropped Frame Counter

Enable disk OS caching

When checked, Control Room will use Disk Caching that is built into the operating 
system when reading and writing files. In many cases this aids short term file 
reading and writing performance (the feature defaults to ON). However in some 
situations with large raster files and many channels of audio this selection can 
reduce performance. In those cases turning disk OS caching OFF may help.
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Timecode Burn In

•	 Disabled - No timecode is displayed.
•	 Playback Only - Reads embedded Timecode data and displays as a real time 

overlay during playback.
•	 Capture Only - Reads embedded Timecode data from input source and burns 

that into then picture area during capture.
•	 Capture & Playback - Both Playback and Capture behaviors are concurrent.

X and Y Position Sliders are also available for changing the location of the 
timecode window on the screen

Save and Load Prefs

The Save Prefs and Load Prefs buttons let you manage your Control Room 
preferences, by saving and loading named prefs files. 

Reset Button

The Reset button will return all Control Room prefs to their factory defaults.

Capture Prefs 

Settings for input signal capture:

Stop Capture/ETT on dropped frames 

In the default preference mode, Control Room will display a red dropped frame 
counter during Capture. If you enable Stop Capture/ETT on dropped frames, the 
counter is not displayed and the process will stop immediately if a dropped frame 
occurs.

Load Clip Settings

Check these boxes to automatically load a clip into the Bin and/or Viewer after 
capture.

Anamorphic Settings

Check this box to mark captured SD MOV files as 16x9 anamorphic.

Capture and Import Paths

Use the Choose button to select the directory paths to be used for Capture and 
Import.
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Mark SD MOV files as 16:9 anamorphic

(Only available for SD input format.) When capturing an anamorphic signal, 
checking the box marks the captured file as anamorphic.  

Viewer Prefs

Enable display-to-desktop and choose format options:

NOTE:	 You can also access Viewer options by Control- or Right-clicking in the Viewer 
Screen.

Enable Viewer

Turns Viewer ON or OFF.

Enable Accelerated OpenGL Viewer

This feature uses the GPU to scale and display video in the Control Room UI. When 
Control Room is launched, it will test the GPU for required functionality, and if it 
passes the test this feature will default to ON. If not, it will be turned OFF. 

In some cases, you can troubleshoot display and performance problems by 
turning this feature OFF. Generally speaking, having it ON will reduce work for the 
CPU, letting the system focus on other tasks like compression/decompression and 
file reading/writing.

Timecode Display

•	 Clip TC (clip timecode)
•	 Frames

Preview Rate During Capture

Select a preview display frame rate during capture, useful  to conserve system 
resources for capture functions:

•	 Full frame rate
•	 2 frames per second
•	 1 frames per second
•	 0 frames per second

Closed Captions Prefs
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Control Room supports embedded captions in QuickTime files and creates side 
car files in .scc and .mcc formats that are stored in the same directory as your 
current project (Capture Path). The files are automatically named the same as the 
subject video clip with the appropriate suffix (.scc and .mcc).

Enable Closed Captioning

To capture and output Closed Captioning using KONA 4/3G, Io4K, Io 4K Plus, or 
Avid | Artist DNxIV, check the Enable Closed Captioning (master enable) box. 

Show CC In Viewer (When Present)

Displays in the Viewer any captions that are present in the video. In this mode, 
Control Room will detect and show captions in Control Room even when an 
external monitor does not support them.

Render CC to video playback (When Present)

Provides a real time overlay of the Closed Captioning data on the video output, 
rather than in the Control Room Viewer. This feature can be used to show Closed 
Captioning on the video monitor display in the bay for the producer, or you can 
output a screener with the Closed Captioning burned in.

Serial Prefs

Settings for serial control via selected timecode source:
•	 AJA Control Panel timecode settings 
•	 Tape deck control via RS-422 port

For information on using Capture and Output offsets to adjust Tape Deck frame 
accuracy, see "Tape Deck Timing Adjustment" on page 24.

Scripting Enable and Tutorial

For users who want to use Python Scripting to operate AJA Control Room, it 
is enabled here and a link to an online tutorial is available. (The tutorial is also 
available in "Appendix B Python Scripting Tutorial" on page 28t.)
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When you enable scripting, a popup message indicates the "Hold device in 
background" setting on the General Preferences page must also be enabled, 
which Control Room can do for you if you click on the Enable and Continue 
button. 

About AJA Control Room
In the Windows OS the About AJA Control Room screen is found under the Help 
menu. In Mac OS it is found in the AJA Control Room pulldown menu.

Figure 3.  About AJA Control Room Screen
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Chapter 2 – Operation
This chapter discusses the details of using the Bin and each of the Viewer Tabs.

Reset to Defaults

AJA Control Room settings can be restored to factory defaults by holding down 
the Control and Shift keys during startup.

Scripting AJA Control Room Operations

AJA Control Room supports Python Scripting. A detailed reference document 
is available on the AJA website. See AJA Control Room Preferences>Scripting to 
enable this feature (refer to "Preferences" on page 7). The Preferences screen 
has a web-link to the documentation.

Using the Bin
The Bin is a list of links to media files in your project directory. 

 

The project directory is defined in the Preferences>General screen where you 
choose a Capture Path and Import Path (see "Preferences" on page 7).

You can begin a new project by selecting New Bin under the File Menu

Adding to the Bin

To add Clips or a DPX folder to your project bin, you can:

1.	 Use the Import Files to Bin command

2.	 Click the plus (+) at the bottom of the Bin, then browse and select a file

3.	 Drag media from the Finder/Explorer to the bin

To open an existing Bin that you have saved, go to the File Menu and select Open 
Bin, then browse and select the Bin (bin files are appended .crbin)

You may also use the Capture Tab to create a new clip and a file that is added to 
the Bin and your directory. This automatic bin addition feature is enabled (the 
default setting) or disabled via a checkbox in Preferences>General.



AJA Control Room Software v14.0	 14	 www.aja.com

﻿

Figure 4.  AJA Control Room Bin 

Meta-data 
header

Right-click 
header 

to display or
hide a speci�c

meta-data
column

Flyout menu 

Moving Clips and Metadata

The Bin panel can be expanded by dragging the right-edge to display a wide 
range of metadata for each clip. Right-click on the Bin metadata header to select 
the specific information columns you want to display (refer to Figure 4).

To further organize the bin, you can move Meta - data columns by dragging and 
dropping header titles to the right or left.

To remove a file from the Bin, you can select it and click the trash can icon. 

NOTE:	 Removing a file does NOT delete the file from your directory but removes the link 
from the Bin.

Bin Item Menu Right Click

If you select a bin item and right-click, you will access this menu.

 

From the menu, you can:
•	 Go to the project directory to access clips
•	 Delete the Bin Item while keeping the clip (content)
•	 Delete Media allows you to delete while keeping the Bin Item (no content) or 

delete both the item and media
•	 Export your project Bin as an Event to Final Cut Pro (Mac OS), see below.
•	 Batch Capture clips (see "Batch Capture" on page 21).
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Export to Final Cut Pro Event

Events in Final Cut Pro X (FCPX) are where you store your project footage. AJA 
Control Room can create an XML file that is read by FCPX which then generates an 
Event containing the selected files.

You can select a clip or group of clips in the bin then right-click to select Export 
Final Cut Pro Event.

The Final Cut Pro X application automatically launches when an Event is 
generated.

NOTE:	 In this process, files are not moved but links to them are created.

Playback Tab
The Playback Tab view screen is the default tab screen. When this mode is 
selected, AJA Control Room allows you to playback, view and trim the clips in 
your project.

Use playback functions for any clips that are loaded in the Bin. Double-click on a 
clip in the bin to open it in the Playback viewer pane.

Figure 5.  AJA Control Room Playback Tab.

 

Playback Dashboard
In Playback mode you can use the dashboard to jog through the clip and set IN 
and OUT points to trim the playback region. These edit points are also used for 
eventual Edit-to-Tape output. 

Standard transport controls are available for advance, stop, and rewind.

Various methods are available to change IN/OUT and Duration values. You can 
enter the cursor and type values into the fields or use keystroke commands.

Keystroke Commands

These keystroke commands are available for manipulating the dashboard.
•	 I = set IN
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•	 O = set OUT
•	 Option + I = clear set IN
•	 Option + O = clear set OUT
•	 Shift + I = go to IN point
•	 Shift + O = go to OUT point

Dragging Markers

You can also drag the marker elements along the timeline to set edit points. Note 
that active elements will display in yellow. The timeline markers (shown below) 
include:

•	 IN slider icon
•	 OUT slider icon
•	 Current Playhead Position Indicator 

Figure 6.  Playback Dashboard 

Set the IN/OUT Points

Perhaps the easiest and most precise method of setting IN/OUT points, is to 
advance the PPI to the desired location and click the Set IN button. Then do the 
same for the Set OUT. 

To view your clip in ontinuous play mode, you can click the Loop button shown 
below.

Figure 7.  Loop Mode, Set IN, and Set OUT Buttons and Indicators 

You can adjust the Set points by click-and-holding in the IN Position or OUT 
Position fields and dragging left or right. 

NOTE:	 The IN/OUT points and Current Playhead position are displayed as either Frames 
or Clip Timecode values depending on your Preference settings.

Playback Video Options
Forvideo options you will find:



AJA Control Room Software v14.0	 17	 www.aja.com

﻿

Auto

Play video and audio tracks at the same frame rate captured

No Video

Play audio tracks only

Frame Rate

Select a speed to play an image sequence such as DPX or DNG files (available 
when an image sequence is loaded for playback)

Audio Meters
The Tab Settings Pane contains meters for 8 or 16 audio channels determined by 
the number of audio channels your AJA edit device supports. 

Figure 8.  Playback Mode Audio Meters 

 

In Playback mode, you can turn audio on/off by clicking on any of the meter 
channels. Option-click a meter to enable/disable all available channels.

You can also re-route audio from any audio input to any audio output. The 
number below each meter indicates the output channel, which is fixed. The 
number above the meter indicates the input channel. Clicking on that number 
opens a dropdown allowing you to choose any other audio input channel, make 
the output channel empty (no input), or reset one or all the channels to the 
default (1 to 1, 2 to 2, etc.) Each input audio channel can be routed to only one 
output channel. 

Audio meter operation for Capture and Edit-To-Tape is different for each mode 
and is described in their respective sections in this chapter.

Capture Tab
Using the Capture Tab, you can create a new clip from the input of your AJA 
device. 
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Figure 9.  AJA Control Room Capture Tab

Input Based Capture

Your AJA device frame buffer must be set for the expected video format either 
via the Control Panel Format setting or the Follow Input function. In the Format 
screen, you enable the Follow Input checkbox which automatically switches the 
buffer format to match the detected input format.

In AJA Control Room you can go to File>AJA Control Panel to open the control 
panel (see "File Menu" on page 6).

Remote Control 

If your input is from a Tape Deck and you have RS-422 connection, AJA Control 
Room provides remote control of the deck and captures according to Timecode 
settings for DURATION, VTR IN, and VTR OUT points (see "Playback Dashboard" on 
page 15). 

Capture mode also supports Batch Capture which automates the process of 
capturing multiple clips from one or more tapes (see "Batch Capture" on page 
21).

NOTE:	 When a Capture is in-progress, the viewer is outlined in red. 

Capture Clip Settings

The Capture Tab provides the Clip Settings pane (shown below) that allows you to 
enter metadata and library information for the clip you will create. In the top row, 
from pulldown menus, you will select format options for the file:

File Types

•	 BMP
•	 CION DNG
•	 DPX
•	 MOV
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•	 MXF
•	 Targa

After a File Type has been selected, a drop down list can be used to select a 
version (encoding, bit depth, etc.) suppored by that file type.

CION DNG Files 

If you are capturing CION DNG files, the format pull-down menu offers supported 
CION formats and will automatically set the AJA Control Panel buffer to your 
selection. All other file types require that you use the Control Panel Follow Input 
mode (see "Input Based Capture" on page 18) or manually verify/set the control 
panel buffer as noted.

Figure 10.  CION File Type and Format Selection Menus

File type menu Frame Rate & 
Geometry menu

MOV Files

NOTE:	 For MOV container files, Control Room supports both DNX HD and, for 
UltraHD/4K input, DNX HR files.

MXF Files

MXF files captured by AJA Control Room are type OP-1A. For MXF container files, 
Control Room supports the following codecs:

•	 AVID DNxHD HQ
•	 AVID DNxHD HQX
•	 AVID DNxHD SQ
•	 AVID DNxHR 444
•	 AVID DNxHR 444 12bit
•	 AVID DNxHR HQ
•	 AVID DNxHR HQX
•	 AVID DNxHD LB
•	 AVID DNxHD SQ
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Clip Naming
A Clip Name will be generated automatically or you can choose to enter your own 
designations for:

•	 File Name
•	 Reel name
•	 Scene description
•	 Take designation. 

NOTE:	 If you want your information to be displayed as part of the Clip Name in AJA 
Control Room, you must enable the check boxes to the right of the entry field. The 
plus (+) buttons are used to add/increment a numeric designation.

Figure 11.  Capture Tab Settings Pane 

Audio Channel Selection

To select audio channels for capture:
•	 Single-click to enable/disable individual channels 
•	 Single-click between the odd/even channel pair numbers (1&2, 3&4, etc.) to 

select audio-pairs (a plus sign will indicate paired channels). In this mode, 
clicking one of the paired meter bars will turn on/off both channels

•	 Option-click to enable/disable all available channels.

Capture Dashboard
The dashboard offers standard tape deck play controls (as described previously) 
and adds the jog control slider. 

AJA Control Room can control a Tape Deck via RS422 or can do manually initiated 
captures. The Tape Deck Control icon indicates the communication status of the 
deck. If no active RS422 connection is present, the icon reports OFFLINE. When 
connected, the status will report:

•	 LOCAL – remote control is not enabled for the VTR
•	 REMOTE – the VTR is set for remote control via RS422

To activate Remote mode:

1.	 Verify the RS422 cable connection between your AJA device and the deck.

2.	 Verify the remote control mode on your recording device is enabled.
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Figure 12.  Capture Buttons & Tape Deck Control Indicator 

Tape Deck icon

NOTE:	 If the Tape Deck icon is lit (yellow), AJA Control Room is detecting an RS-422 
connection that is active. If it is white, there is no active RS422 connection.

Two record buttons are available:
•	 Start tape capture - captures from the deck according to timecode VTR IN and 

VTR OUT settings.
•	 Start capture - initiates immediate manual capture of the AJA device input. 

You can also use keystroke commands CMD R (Mac) and CTRL R (Windows) to 
initiate capture and the ESC key to stop.

Batch Capture
The batch capture procedure consists of these steps:

1.	 Create bin items without content by entering:
•	 File Type and Clip information in the capture tab settings pane
•	 IN Point and OUT Point or Duration information for the clip.

2.	 Click the Pencil icon. You will see a red line through the bin icon that 
indicates “Footage is offline”.

Repeat this process for additional bin items.

NOTE:	 You can enter bin items from different tapes entering the numbers in the Tape 
field (Clip information). The batch capture will pause for tape change and resume 
to complete the batch.

3.	 When all the bin items are listed, select them in the bin and right-click to 
select Batch Capture from the resulting menu.

Next, in the options screen you can set the Capture type to:
•	 All Selected Items – captures content for all selected bin items, or
•	 Offline Items Only – captures content only for items in the bin with “footage 

offline”

Under Options, Use Logged Clip Settings is for future use. You may enable  
Add Handles to add pre- and post-footage to your captures. After setting Batch 
Capture Options, click Continue.

Figure 13.  Batch Capture Options Screen 

 

4.	 On the Batch Capture Screen, you may
•	 Select a single item and click Capture Clip to capture one item
•	 Click on Capture Tape to capture all listed items. 
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AJA Control Room will sequentially record multiple clips into the project directory 
and assign the bin item links as the capture media is run. 

Figure 14.  Batch Capture Screen 

You can right-click in the bin to delete a bin item, its media content, or both, from 
the bin (refer to "Bin Item Menu Right Click" on page 14). If you keep the bin item 
and delete the media, the bin item icon’s red line returns.

Edit-To-Tape Tab
Using the Edit-To-Tape tab you can output your current clip to a tape deck or 
recording device using remote control. A tape deck connected via RS-422 and 
set in remote control mode allows AJA Control Room to send an Insert Edit or 
Assemble Edit with timecode VTR IN and VTR OUT or Duration designated.
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Figure 15.  Edit-To-Tape Tab 

Edit To Tape Dashboard

The dashboard for Edit-To-Tape provides the same functions as described for 
Capture mode (see "Capture Dashboard" on page 20).

Edit Settings Pane

Operation Type:

•	 Insert – lays down selected video and audio tracks using timecode VTR IN/VTR 
OUT or Duration maintaining existing control tracks on the tape.

•	 Assemble – erases previous content and records all video, audio, timecode, 
and control track information onto tape according to the timecode 
information (VTR IN/VTR OUT/Duration) set in AJA Control Room.

Edit Track Content

The Video checkbox allows you to include/exclude Video content in an Insert Edit 
(not applicable to Assemble Edits). 

If you check the Preview box, you can use the play control to view the content in 
AJA Control Room without recording it to the deck.
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Figure 16.  Edit-To-Tape Dashboard & Tab Settings Pane 

Audio Track Inclusion

In Insert mode you have complete control of the individual audio tracks you want 
to include in the edit. Click on each track you want to enable/disable or Option-
click to enable/disable all available tracks. An Assemble edit has no control of the 
audio track selection.

Tape Deck Timing Adjustment
Both Capture and Edit-To-Tape operations employ Timecode for executing 
seamless frame-accurate operation. Latency in communication between devices 
can cause delays of several frames depending on the signal format and tape 
machine being used. To fine-tune timing between the tape deck and your 
computer and AJA edit device I/O, open AJA Control Room Preferences and select 
the Serial screen.

Figure 17.  AJA Control Room Serial Preferences Screen

In the following procedure, you will use the Capture Offset for Capture timing and 
Output Offset for Edit-To-Tape. Offset values presented are in whole Frames and 
tenths. 

Offset Adjustment Procedure

This procedure is basically the same for both Capture and Edit-to-Tape 
adjustment. 
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You will enter an Offset value and then capture or output-to-tape a number of 
clips while checking the resultant timecode accuracy. 

We recommend ten edits or captures (with timecode burn-in output from the 
VTR) be examined. 

Machine and Video Format Changes

If you use multiple tape deck types, you will want to perform and record these 
adjustments for each. 

Timing can vary between deck manufacturers and models. Also, changing video 
formats between 30 fps video (eg.1080i 29.97) and 50 to 60 fps video (720p 59.94) 
may require offset adjustment. 

Our experience indicates required offsets will be approximately:
•	 2.0 frames for 30 fps formats
•	 1.0 frames for 60 fps formats

Capture Timing
NOTE:	 For Capture testing, you can use Batch Capture to quickly generate a series of 

sample captures.

Capture Adjustment Procedure

1.	 Enter your Capture Offset (1 frame for this example).

2.	 Set an IN Point for the Capture noting it’s timecode.

3.	 Set a 2 second Duration or an OUT Point.

4.	 Click the Tape Capture button to start the capture.

5.	 When Capture is complete, double-click on the clip in the bin to enter 
Playback mode. 

6.	 Compare the first two frames of the burned-in timecode of the capture with 
the timecode values in the dashboard’s Current Position Indicator (CPI).

7.	 If the capture resulted in a timecode beginning a frame before the CPI, 
adjust the offset by adding a frame. Conversely, if the clip was late, decrease 
the offset.

As you perform more trial captures, you may see a variance in frame accuracy. If 
so, you can use the tenth-of-a-frame offset (beginning with five-tenths) to make 
more subtle adjustment until the clip timecode and CPI consistently match.

NOTE:	 720p 50 to 60 fps formats actually records 2 frames for each timecode frame 
value. For frame accuracy you must check that the timecode value does not 
change for the first two frames of video.

Edit-to-Tape Timing
For Edit-to-Tape Timing you enter frame values in the Output Offset field in Serial 
Preferences. AJA Control Room must begin playout so that the correct frame is 
on-air at the edit IN point.
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Edit Adjustment Procedure

Begin the procedure by doing a test edit.

1.	 Using a clip with timecode burn-in, select a CPI point marking the desired 
edit IN.

2.	 Set a 2 second Duration or an OUT Point

.

3.	 Click the Tape start button to perform the edit.

4.	 When the edit is complete, roll the tape back to the edit IN point and verify 
that the first frame that was captured on tape was the frame you expected.

5.	 If the edit begins a frame early, adjust the offset by adding a frame. 
Conversely, if the clip was late, decrease the offset.

As you perform more trial edits, you may see a variance in frame accuracy. If so, 
you can use the tenth-of-a-frame offset (beginning with five-tenths) to make 
more subtle adjustment until the edit is consistently frame-accurate.

Again, for video formats of 720p 50 to 60 fps, refer to the Note above.
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Appendix A – Supported Read/Write Codecs
Control Room supports the compressors listed in the capture settings dropdown 
lists.  Different selections are available under different conditions.

The following table lists the read and write capabilities of Control Room by codec 
and operating system.

Table 1.  Control Room Supported Read and Write Codecs by Operating System

Codec WIN OS MAC OS LINUX 
Red Hat/CentOS

LINUX 
Ubuntu

ProRes Read Yes Yes No No

ProRes Write No Yes No No

DNxHD Read - MOV Yes Yes Yes Yes

DNxHD Write - MOV Yes Yes Yes Yes

DNxHD Read - MXF Yes Yes Yes Yes

DNxHD Write - MXF Yes Yes Yes Yes

DNxHR Read - MOV Yes Yes Yes Yes

DNxHR Write - MOV Yes Yes Yes Yes

DNxHR Read - MXF Yes Yes Yes Yes

DNxHR Write - MXF Yes Yes Yes Yes

DVCProHD Read Yes Yes No No

DVCProHD Write Yes Yes No No

GoPro CineForm Read Yes No No No

GoPro CineForm Write Yes No No No

DPX Read Yes Yes Yes Yes

DPX Write Yes Yes Yes Yes

CION DNG Read No Yes No No

CION DNG Write No Yes No No

BMP Read Yes Yes Yes Yes

BMP Write Yes Yes Yes Yes

Targa Read Yes Yes Yes Yes

Targa Write Yes Yes Yes  Yes

AJA TV Playback
Many additional file types can be played using the AJA TV application that is 
installed in the AJA Utilities folder. AJA TV uses QuickTime technology, allowing 
you to use almost any digital video format available. 
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Appendix B – Python Scripting Tutorial
AJA has implemented a Python Scripting interface for the AJA Control Room 
application.

Under Python script control you can:
•	 Name the file to be captured
•	 Start Capturing
•	 Stop Capturing
•	 Load Files into the bin
•	 Use transport controls
•	 Get a list of files in the bin
•	 Set the mode (Capture, Playback, Edit To Tape)
•	 Show/Hide the Bin and Settings panes 

NOTE:	 Our implementation is based upon Python v2.7. Version 3.4 will not work. 

This tutorial and the example files are available as a download in the Documents 
section from:

https://www.aja.com/software/control-room/tutorials

Python Installation

Windows
The Python libraries are not installed with Windows by default. You can get the 
Python 2.7.6 installer from:

https://www.python.org/downloads/windows/

Once this is installed, you must set an environmental variable to point to your 
Python installation. To add an Environmental Variable for Python:

1.	 Right-click My Computer, and then click Properties.

2.	 Click the Advanced System Settings.

3.	 Click Environment Variables.

Figure 18.  Environent Variables Screen

4.	 Click one the New buttons to add either a User or a System variable:

5.	 Enter the name and value. 

https://www.aja.com/software/control-room/tutorials
https://www.python.org/downloads/windows/
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Figure 19.  Python Environment Variable Window

6.	 Click OK.

Apple Macintosh
Python v2.7 is installed as part of the standard Mac OSX 10.8 and 10.9 system 
install. No additional installation is necessary.

AJA Control Room Setup for Python Scripting
1.	 Copy the python folder to your desktop. It can be copied anywhere, but for 

this example we will expect it to be on your Desktop

2.	 Launch the AJA Control Room application

3.	 Open the AJA Control Room Preferences

4.	 Select the Scripting pane
•	 Make sure Enable Scripting Server is checked
•	 The Scripting server port defaults to Port 8080. 

NOTE:	 You can change this if desired but our example code expects it to be set to Port 
8080. If you modify this port number you must change the appropriate value in 
the code to match.

5.	 Select the General pane and
•	 Make sure Hold onto device when app is in background is checked
•	 Make sure a Capture Path is specified

6.	 Dismiss Preferences window

7.	 Select Capture tab in Main window
•	 Specify desired File Type
•	 Specify desired Video Codec
•	 Specify desired Audio Codec
•	 Specify number of Audio Channels
•	 Confirm that the checkbox next to the File Name field is checked

Macintosh Instructions
1.	 Make sure the AJA Control Room app is running and is set up as described 

above.

2.	 Open the Terminal application

3.	 Type cd ~/Desktop/python/examples

4.	 Type ./testcapture.py to run the testcapture Python script. 

The testcapture script tells AJA Control Room to capture a 1 second clip called 
“testClip”. The captured clip will appear in the bin.
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Figure 20.  Desktop Python Examples

Windows Instructions
The following instructions expect the AJA Python folder to be on your Desktop. 
Make sure the AJA Control Room application is running.

1.	 Open up a Command Prompt

2.	 Type cd %HOMEPATH%\Desktop\python\examples

3.	 Type testcapture.py to run the testcapture Python script. 

The testcapture script tells AJA Control Room to capture a 1 second clip called 
“testClip”. The captured clip will appear in the bin.

Figure 21.  Command Prompt Entries

Simple Modifications
Following is the code for testcapture.py

You can change the duration of the capture by changing the number (in seconds) 
in the parentheses in line 15 time.sleep(1)

The name of the file to be captured comes from the word in quotes in line 26 
(“testClip” in the example below) captureTest(client, “testClip”)

This script is meant to control the AJA Control Room app on the local computer, 
however you can control an AJA Control Room app on a different computer 
on the network by replacing ‘localhost’ on line 22 with the IP address (e.g. 
10.192.168.40) of another computer on your network. If the Scripting server port 
in the Scripting Preferences has been changed you must match that port number 
in line 23. An instance of the AJA Control Room app must be running on the 
remote computer.
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Figure 22.  Example Python script “testcapture.py”
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Figure 23.  Example Python script “testplayback.py”
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Software License Agreement
AJA VIDEO SYSTEMS, INC. 

PLEASE READ THIS SOFTWARE LICENSE AGREEMENT (“LICENSE”) BEFORE USING THE 
SOFTWARE. BY USING THE SOFTWARE, YOU ARE AGREEING TO BE BOUND BY THE 
TERMS OF THIS LICENSE. IF YOU ARE ACCESSING THE SOFTWARE ELECTRONICALLY, 
SIGNIFY YOUR AGREEMENT TO BE BOUND BY THE TERMS OF THIS LICENSE BY 
CLICKING THE “AGREE/ACCEPT” BUTTON. IF YOU DO NOT AGREE TO THE TERMS OF 
THIS LICENSE, RETURN THE AJA SOFTWARE TO THE PLACE WHERE YOU OBTAINED 
IT FOR A REFUND OR, IF THE SOFTWARE WAS ACCESSED ELECTRONICALLY, CLICK 
“DISAGREE/DECLINE”.

IMPORTANT NOTE: To the extent this software may be used to reproduce materials, 
it is licensed to you only for reproduction of materials you are authorized or legally 
permitted to reproduce. 

1. General. The software and documentation accompanying this License whether 
on disk, in read only memory, on any other media or in any other form (collectively 
the “AJA Software”) are licensed, not sold, to you by AJA Video Systems, Inc. (“AJA”) 
for use only under the terms of this License, and AJA reserves all rights not expressly 
granted to you.   The rights granted herein are limited to AJA's and its licensors' 
intellectual property rights in the AJA Software and do not include any other patents 
or intellectual property rights.   You own the media on which the AJA Software is 
recorded but AJA and/or AJA's licensor(s) retain ownership of the AJA Software itself. 
The rights granted under the terms of this License include any software upgrades that 
replace and/or supplement the original AJA Software product. 

2. Permitted License Uses and Restrictions. This License allows you to install and 
use AJA Software on a computer. You may make copies of the AJA Software in 
machine-readable form for backup purposes only; provided that the backup copy 
must include all copyright or other proprietary notices contained on the original. 
Except as and only to the extent expressly permitted in this License or by applicable 
law, you may not copy, decompile, reverse engineer, disassemble, modify, or create 
derivative works of the AJA Software or any part thereof. THE AJA SOFTWARE IS 
NOT INTENDED FOR USE IN THE OPERATION OF NUCLEAR FACILITIES, AIRCRAFT 
NAVIGATION OR COMMUNICATION SYSTEMS, AIR TRAFFIC CONTROL SYSTEMS, LIFE 
SUPPORT MACHINES OR OTHER EQUIPMENT IN WHICH THE FAILURE OF THE AJA 
SOFTWARE COULD LEAD TO DEATH, PERSONAL INJURY, OR SEVERE PHYSICAL OR 
ENVIRONMENTAL DAMAGE.   

3. Transfer. You may not rent, lease, lend or sublicense the AJA Software. You may, 
however, make a one-time permanent transfer of all of your license rights to the AJA 
Software to another party, provided that: (a) the transfer must include all of the AJA 
Software, including all its component parts, original media, printed materials and this 
License; (b) you do not retain any copies of the AJA Software, full or partial, including 
copies stored on a computer or other storage device; and (c) the party receiving the 
AJA Software reads and agrees to accept the terms and conditions of this License. NFR 
(Not for Resale) Copies: Notwithstanding other sections of this License, AJA Software 
labeled or otherwise provided to you on a promotional basis may only be used for 
demonstration, testing and evaluation purposes and may not be resold or transferred.

4. Termination. This License is effective until terminated. Your rights under this License 
will terminate automatically without notice from AJA if you fail to comply with any 
term(s) of this License. Upon the termination of this License, you shall cease all use of 
the AJA Software and destroy all copies, full or partial, of the AJA Software.

5. Limited Warranty on Media. AJA warrants the media on which the AJA Software is 
recorded and delivered by AJA to be free from defects in materials and workmanship 
under normal use for a period of ninety (90) days from the date of original retail 
purchase. Your exclusive remedy under this Section shall be, at AJA’s option, a refund 
of the purchase price of the product containing the AJA Software or replacement 
of the AJA Software which is returned to AJA or an AJA authorized representative 
with a copy of the receipt. THIS LIMITED WARRANTY AND ANY IMPLIED WARRANTIES 
ON THE MEDIA INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY, OF SATISFACTORY QUALITY, AND OF FITNESS FOR A PARTICULAR 
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PURPOSE, ARE LIMITED IN DURATION TO NINETY (90) DAYS FROM THE DATE OF 
ORIGINAL RETAIL PURCHASE. SOME JURISDICTIONS DO NOT ALLOW LIMITATIONS 
ON HOW LONG AN IMPLIED WARRANTY LASTS, SO THE ABOVE LIMITATION MAY NOT 
APPLY TO YOU. THE LIMITED WARRANTY SET FORTH HEREIN IS THE ONLY WARRANTY 
MADE TO YOU AND IS PROVIDED IN LIEU OF ANY OTHER WARRANTIES (IF ANY) 
CREATED BY ANY DOCUMENTATION OR PACKAGING. THIS LIMITED WARRANTY GIVES 
YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY ALSO HAVE OTHER RIGHTS WHICH VARY 
BY JURISDICTION.

6. Disclaimer of Warranties. YOU EXPRESSLY ACKNOWLEDGE AND AGREE THAT 
USE OF THE AJA SOFTWARE IS AT YOUR SOLE RISK AND THAT THE ENTIRE RISK 
AS TO SATISFACTORY QUALITY, PERFORMANCE, ACCURACY AND EFFORT IS WITH 
YOU. EXCEPT FOR THE LIMITED WARRANTY ON MEDIA SET FORTH ABOVE AND TO 
THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE AJA SOFTWARE IS 
PROVIDED “AS IS”, WITH ALL FAULTS AND WITHOUT WARRANTY OF ANY KIND, AND 
AJA AND AJA'S LICENSORS (COLLECTIVELY REFERRED TO AS “AJA” FOR THE PURPOSES 
OF SECTIONS 6 AND 7) HEREBY DISCLAIM ALL WARRANTIES AND CONDITIONS 
WITH RESPECT TO THE AJA SOFTWARE, EITHER EXPRESS, IMPLIED OR STATUTORY, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR CONDITIONS 
OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS FOR A PARTICULAR 
PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND NON-INFRINGEMENT OF 
THIRD PARTY RIGHTS. AJA DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR 
ENJOYMENT OF THE AJA SOFTWARE, THAT THE FUNCTIONS CONTAINED IN THE AJA 
SOFTWARE WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE AJA 
SOFTWARE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE AJA 
SOFTWARE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE 
GIVEN BY AJA OR AN AJA AUTHORIZED REPRESENTATIVE SHALL CREATE A WARRANTY. 
SHOULD THE AJA SOFTWARE PROVE DEFECTIVE, YOU ASSUME THE ENTIRE COST OF 
ALL NECESSARY SERVICING, REPAIR OR CORRECTION. SOME JURISDICTIONS DO NOT 
ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON APPLICABLE 
STATUTORY RIGHTS OF A CONSUMER, SO THE ABOVE EXCLUSION AND LIMITATIONS 
MAY NOT APPLY TO YOU.

7. Limitation of Liability. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT 
SHALL AJA BE LIABLE FOR PERSONAL INJURY, OR ANY INCIDENTAL, SPECIAL, INDIRECT 
OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUDING, WITHOUT LIMITATION, 
DAMAGES FOR LOSS OF PROFITS, LOSS OF DATA, BUSINESS INTERRUPTION OR ANY 
OTHER COMMERCIAL DAMAGES OR LOSSES, ARISING OUT OF OR RELATED TO YOUR 
USE OR INABILITY TO USE THE AJA SOFTWARE, HOWEVER CAUSED, REGARDLESS OF 
THE THEORY OF LIABILITY (CONTRACT, TORT OR OTHERWISE) AND EVEN IF AJA HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. SOME JURISDICTIONS DO 
NOT ALLOW THE LIMITATION OF LIABILITY FOR PERSONAL INJURY, OR OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In no 
event shall AJA's total liability to you for all damages (other than as may be required 
by applicable law in cases involving personal injury) exceed the amount of fifty dollars 
($50.00). The foregoing limitations will apply even if the above stated remedy fails of 
its essential purpose.

8. Export Law Assurances. You may not use or otherwise export or reexport the AJA 
Software except as authorized by United States law and the laws of the jurisdiction in 
which the AJA Software was obtained. In particular, but without limitation, the AJA 
Software may not be exported or re-exported (a) into (or to a national or resident 
of) any U.S. embargoed countries (currently Cuba, Iran, Iraq, Libya, North Korea, 
Sudan and Syria) or (b) to anyone on the U.S. Treasury Department's list of Specially 
Designated Nationals or the U.S. Department of Commerce Denied Person’s List or 
Entity List. By using the AJA Software, you represent and warrant that you are not 
located in, under control of, or a national or resident of any such country or on any 
such list.

9. Government End Users. The AJA Software and related documentation are 
“Commercial Items”, as that term is defined at 48 C.F.R. ¤2.101, consisting 
of “Commercial Computer Software” and “Commercial Computer Software 
Documentation”, as such terms are used in 48 C.F.R. ¤12.212 or 48 C.F.R. ¤227.7202, as 
applicable. Consistent with 48 C.F.R. ¤12.212 or 48 C.F.R. ¤227.7202-1through 227.7202-
4, as applicable, the Commercial Computer Software and Commercial Computer 
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Software Documentation are being licensed to U.S. Government end users (a) only as 
Commercial Items and (b) with only those rights as are granted to all other end users 
pursuant to the terms and conditions herein. Unpublished-rights reserved under the 
copyright laws of the United States.

10. Controlling Law and Severability. This License will be governed by and construed 
in accordance with the laws of the State of California, as applied to agreements 
entered into and to be performed entirely within California between California 
residents. This License shall not be governed by the United Nations Convention on 
Contracts for the International Sale of Goods, the application of which is expressly 
excluded. If for any reason a court of competent jurisdiction finds any provision, or 
portion thereof, to be unenforceable, the remainder of this License shall continue in 
full force and effect. 

11. Complete Agreement; Governing Language. This License constitutes the entire 
agreement between the parties with respect to the use of the AJA Software licensed 
hereunder and supersedes all prior or contemporaneous understandings regarding 
such subject matter. No amendment to or modification of this License will be binding 
unless in writing and signed by AJA. Any translation of this License is done for local 
requirements and in the event of a dispute between the English and any non-English 
versions, the English version of this License shall govern.
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